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1. Overview 
The ShakeAlert Earthquake Early Warning System detects significant earthquakes so 
quickly that alerts can reach many people seconds to several tens of seconds before 
shaking arrives.  
 
ShakeAlert is being developed with public and private Partners, which include: the U.S. 
Geological Survey, the California governor’s Office of Emergency Services, Oregon Office 
of Emergency Management, Washington State Emergency Management Agency,  the 
California Geological Survey, the Oregon Department of Geology and Mineral Industries, 
the Gordon and Betty Moore Foundation, the California Institute of Technology, the 
University of California Berkeley, the University of Washington, the University of 
Oregon, the University of Nevada Reno, and Central Washington University. 
 
ShakeAlert information is distributed by the United States Geological Survey (USGS).  
ShakeAlert UserDisplay is a User-facing demonstration product of the ShakeAlert 
Earthquake Early Warning (EEW) System which will help potential partners 
understand how the ShakeAlert System works and the products it produces in order to: 
(1) evaluate their ability to become an end user or product co-developer of software or 
hardware solutions for the purpose of triggering automated actions, or (2) develop 
technologies to perform useful actions when alerts are received.  The UserDisplay is 
only one of potentially many ways to communicate ShakAlerts and has a specific use for 
critical users. 
 
Originally made available to a limited group of ‘Beta Test Users’ to test EEW algorithms 
and software, the UserDisplay is now available to 24/7 emergency operations and 
dispatch centers who require additional information to make quick response decisions.  
 
The UserDisplay is a Java-based application that has been developed to receive the XML 
formatted messages from the ShakeAlert System, which notifies Users. The UserDisplay 
rapidly and simply displays ShakeAlert earthquake early warning  information that can 
be viewed on the User’s computer. 
 
The UserDisplay shows the User's location and the estimated epicenter of the 
earthquake. As time elapses from the detection and notification of an event, the current 
locations of the P- and S-wave fronts are also shown, as well as the estimated 
magnitude, predicted intensity of shaking at the User's site, and remaining time until 
this shaking is expected to start at that User’s location. If the UserDisplay is configured 
to ingest contour or map messages (a new feature in V2.7.0), estimated shaking 
intensity across the map display will also be shown.  
 
The UserDisplay pops-up automatically if a new earthquake alert message is received 
that exceeds the minimum thresholds for magnitude and intensity  (see section Menus 
> Top Menu Bar > Edit > Settings > Event Filter Parameters for details of the User 
threshold behavior). Note:  Computer cannot be off or in sleep mode to receive alerts. 
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XML-format alert messages received by the UserDisplay are stored locally on the User's 
computer and can be replayed. To ensure robust communication, the UserDisplay 
receives and displays heartbeats that provide a summary of the state of health of the 
components (e.g. algorithms) of the ShakeAlert system.  
 
ShakeAlert currently combines the output from two independently running algorithms, 
FinDer and EPIC, that use recorded ground motion data to estimate source parameters 
for an ongoing earthquake.  ShakeAlert provides a continuum of earthquake alert 
information including rapid estimates of magnitudes, locations, and expected seismic 
intensities. Earthquake magnitude represents the amount of energy released and 
depends on the surface area of the rupture. Seismic intensity is the amount of shaking, 
and is a relevant measure for potential damage.  
 
UserDisplay Users are not authorized to copy, modify, reverse-engineer, publish, rent, 
lease, loan, sublicense, or distribute ShakeAlert Materials or derived products to any 
third-party without the prior written consent of the USGS. Additionally, Users must 
obtain prior written approval from the USGS for any public information releases which 
refer to the Department of the Interior, the USGS, its employees, or ShakeAlert 
Materials. Testing of  ShakeAlert is ongoing; the USGS and its partners are in the process 
of acquiring the resources to build a system that will be available to the public. 
 
The USGS does not warrant that ShakeAlert Materials will function at all times, in all 
geographic areas, be error-free or that any errors will be corrected.  Users should not 
take critical actions or make important decisions based on ShakeAlert information. 
 
ShakeAlert’s Joint Committee for Communication, Education, and Outreach is 
collaborating with a variety of stakeholders, including UserDisplay Users, to develop 
messaging and visual representations of ShakeAlert data. Input from the ShakeAlert 
User community is indispensable in this process. 
 
The USGS seeks well-qualified partners to cooperatively develop projects that use the 
ShakeAlert System earthquake early warning notification products in real-world 
applications.  Applicants must be willing and able to commit their resources to 
implementing one or more specific applications to the point of practical use.  Note that 
the ShakeAlert earthquake detection network is not yet complete but alert servers are 
operational and “open for business” in California, Washington, Oregon.  Projects may be 
for use within your organization or with the aim of developing products and services 
for sale to clients: go to  https://shakealert.org/implementation/partners  for 
information on how to become a Pilot Partner.  
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2. Download and Installation 
 
Currently, the ShakeAlert UserDisplay program is only being distributed to a limited 
number of partners to provide feedback/support for further development, or to 
evaluate their capacity to develop pilot projects that demonstrate the use of ShakeAlert 
Earthquake Early Warning alerts (ShakeAlerts) and data streams in real-world 
applications.  
 
Upon being authorized to access ShakeAlert UserDisplay, you have been issued a 
personal username and password for installation. 
 
Do not share your personal username and password with others.* 
 
*The ShakeAlert Project maintains the right to refuse access to anyone at any time without notice. 
 
Step 1. Download software 

● Go to https://www.shakealert.org. 
● Within the home page for shakealert.org, access ShakeAlert Utilities at the 

bottom right-hand side of the page.  
● The Utilities page is protected with a generic password which was provided to 

you with your access codes.  
● Access the Download and Installation tab. 
● It is recommended that you read the README file in the download directory for 

further information on system requirements, installation and relevant updates 
before you download the software. 

 
Step 2. Select the installation appropriate to your operating system for download 

● Windows: UserDisplay-X.X.X_yyyymmdd.installer.exe 
● Mac: UserDisplay-X.X.X_yyyymmdd-osx.installer.dmg 
● Linux: UserDisplay-X.X.X_yyyymmdd-linux.installer.run 
● UNIX: UserDisplay-X.X.X_yyyymmdd.tgz 

             (On UNIX, after extracting the files from the tgz archive, to run, use the 
runUNIX.sh script) 

 
Step 3. Uninstall UserDisplay current versions 
 
You must stop now and uninstall any previous build of the current version 2.7.0 of the 
UserDisplay, such as a beta or pre-release version.  Failure to stop and uninstall before 
installing the same version of UserDisplay could cause a currently running program to  
lock up and/or cause the installation to fail. You may need to reboot your computer if you 
do not stop the program before uninstalling.  
 
If you are running an earlier version of the UserDisplay (2.6.0 or earlier) you can uninstall 
it AFTER you successfully install the new version 2.7.0.  
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After you have installed version 2.7.0 you can copy any history files from a previous 
version to keep them available for replay.  See README file for instructions: 
https://www.shakealert.org/eew-research/caltech/shakealert-user-display/shakealert
-utilities/shakealert-utilities-2/documentationuser-guides/ 
 
To uninstall older UserDisplay versions on your computer use the uninstaller in the 
program installation directory, or on Windows you can also use the general program 
uninstaller available through the Control Panel. To uninstall older versions: 

● Mac: drag the UserDisplay folder to the trash. 
● Windows: use the Control Panel uninstall option (Start menu > Control Panel > 

Programs and Features > right-click on a program and select uninstall). 
● Linux/Unix: delete the UserDisplay folder. 

 
Step 4. Install Program 
When you run the installer you will be asked to accept the USGS End User License 
Agreement. Please read the EULA carefully. 
 
Step 5: Run UserDisplay 
Once the program is fully installed, you should find a shortcut for the UserDisplay on 
your Desktop.  

 
Double-click on the icon and enter your personal username and password to start your 
ShakeAlert UserDisplay. Do not forget to turn on your computer’s volume so you can 
hear the alert tone and voice announcements when an alert message is received. 
 
When you run or execute the UserDisplay program, it will request your personal 
username and password. Additionally, the first time you run the software you will need 
once more to accept the USGS End User License Agreement, in case the program was 
installed by a different user. 
 
The first time you run a new version of ShakeAlert you will need to manually enter your 
personal username and password. If you need to see your password in clear text 
during or after you enter it on the dialog, check the “Show PassPhrase” box. If you check 
the “Autologin” box under Settings you will not need to enter your credentials again 
unless you install a new version. Please note that you should only check the “Autologin” 
box once you have verified that your credentials are correct, by seeing the connection 
status change to green after your first log in. Also, remember to go into “Settings” and 
enter your latitude/longitude to set your location, map center and your magnitude and 
intensity thresholds for receiving alerts.  For further information on setting alert 
thresholds, or other parameters, please see section Menus > Top Menu Bar > Edit > 
Settings. 
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On Windows or Mac OSX you can set the ShakeAlert UserDisplay to be restarted 
automatically when your computer is restarted. On Windows, the installer will set the 
auto re-start option by default (to disable use Windows Task Manager > Settings > 
Startup). On Mac OSX, put the UserDisplay application program in the list of "Login 
items" for your user (System preferences > Users and Groups > Login Items). 
 
If you experience technical difficulties with the UserDisplay or have any comments, 
please contact the appropriate ShakeAlert Regional Coordinator: 
 

Southern 
California 

Margaret Vinci  
(Caltech) 

mvinci@gps.caltech.edu 626-395-3298 

Northern 
California 

Jennifer Strauss  
(UC Berkeley) 

jastrauss@berkeley.edu 510-642-1067 

Oregon Lucy Walsh 
(University of Oregon) 

lwalsh@uoregon.edu 541-346-4654 

Washington Bill Steele  
(University of Washington) 

wsteele@uw.edu 
 

206-685-5880 

USGS Robert de Groot  
(USGS) 

rdegroot@usgs.gov 626-583-7225 

 
Additional information regarding the ShakeAlert earthquake early warning system can 
be found at https://www.shakealert.org. 
 
Recent earthquake information can be found at: http://www.scsn.org (SoCal), 
http://www.pnsn.org (PNW), 
http://earthquakes.berkeley.edu/seismo.real.time.map.html (NorCal), or 
http://earthquake.usgs.gov. 
 
The ShakeAlert UserDisplay is a platform-independent Java Application. The program 
has been successfully tested on Windows 7, 8, and 10; Windows Vista; Windows XP; 
Linux; and Mac OS X. The program requires Java version 1.8 or higher. Please follow the 
instructions of the installation manager. You must grant the UserDisplay access through 
your firewall to be able to receive alert messages from the ShakeAlert system. 
 
Note: Within the ShakeAlert Utilities webpage, the Bug Report/Enhancement Request 
Submission tab allows you to provide UserDisplay feedback to the UserDisplay 
development team. 
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Recent Changes 
Based on the feedback from our Beta Test Users and advances in algorithm 
development, the following changes were made to the UserDisplay: 
 
1) The latest 2.7.0 version offers the following improvements and new features: 

● Updated audio files, for both voice and alert tone, with new user options to select 
between different audio alerting. 

● Support for the ShakeAlert v2.0 XML message formats, including changes to 
encoding of: finite fault data, ground motion point observations, ground motion 
contours, ground motion map. 

● Support for different ShakeAlert message topics, allowing the User to select to 
subscribe to messages containing: only earthquake parameters; earthquake 
parameters plus estimates of ground motion contours; earthquake parameters 
plus a map grid of estimated shaking. 

● Support to visualize estimated ground motion contours or map grid if the User 
subscribes to the relevant message topic. These are optional as new map layers. 

● Additional support to plot PNW stations in station layer. 
● Example replay data have been reorganized into region folders, within which is a 

point source folder, with .xml files for events with a single alert, and folders for 
scenarios (usually finite fault) with multiple updates. The SYN_ folders contain 
.eew files that will replay a sequence of .xml files found in the xml_files folders. 
Any individual .xml file can also be replayed. 

● The replay menu now provides a list of recently played earthquakes for easy 
replay. List entries include the event ID (usually including date and time for 
events received in real-time), magnitude, nearest city, and number of updates. 

● Changes have been made to the contents of the editable map layers, giving the 
User more control over individual pieces of information and optimising display 
updates. Using the edit layers dialog allows the user to switch map features on 
and off, re-order, add or remove them. 

● Additional information is provided in the Help > About popup that allows the 
user to see the time the program was started, user information, system 
description, software library details and the UserDisplay properties file. 

 
2) Bug fixes for v2.7.0 are listed in the changes file launched from the Help > Changes 

menu option. 
 
3) ShakeAlert UserDisplay v2.7.0 requires Java 1.8 or newer. NOTE: There is a known 

problem with the current Java 8 update 121, which was released January 17, 2017. 
This may cause the UserDisplay to flicker/incompletely refresh and/or the audio to 
be uneven during an earthquake alert. It affects some video cards. Previous versions 
of the UserDisplay may also be affected by the recent java updates. Reverting to 
versions of Java 8 prior to 101 should improve the display. It may also help to 
disable some of the more detailed map layers. 
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3. Menus 
There are three menu bars along the top of the ShakeAlert UserDisplay window.  

 
 
Top Menu Bar 

The Top Menu Bar displays items that, when clicked, reveal pull-down submenus of 
choices to select. 
 
UserDisplay 
Click this drop-down to turn off alarms, cancel events, reconnect to program services, 
or exit. 

● Silence Alarms quiets a current alarm. You can also use keyboard shortcut Ctrl-S 
or click Silence button on the Button bar. This feature mutes ONGOING alerts, 
for example to suppress audio alerts for distant earthquakes with long warning 
times that may be irrelevant to the User. 

● Mute All Alarms will silence all incoming and simulated alarms until the mute is 
deselected. You can also mute alarms by clicking the Mute checkbox on the 
Button bar, or by using keyboard shortcut Ctrl-M. The keyboard shortcut will 
toggle Mute on and off. You may wish to use this feature if there is an ongoing 
event swarm, or if you work in a quiet environment where a visual alert is 
sufficient. 

● Cancel Event stops an event alarm from proceeding, whether an actual alarm or 
an example simulation. If you cancel an event, you will no longer get updates of 
that event. Unless you are demonstrating ShakeAlert and making use of 
example simulations, you should not use the Cancel Event button, because it 
may result in you not receiving relevant alerts as earthquake parameters are 
updated (e.g. as earthquake rupture proceeds it may move closer to your 
location).  

● Reconnect to ShakeAlert Server will attempt to reconnect your UserDisplay to the 
ShakeAlert system; if successful, your Program Status Light will turn green (for 
more details on the status light, see the Button Bar section). 

● Reconnect to Time Server will sync your program with the NTP (official time) 
server. If you get message “NTP Status is currently OK”, you don’t have to 
reconnect or “restart” the NTP synchronization. 

● Exit will quit the UserDisplay. You can also click the Power-off icon to quit, 
located directly below on the Button bar (see Button Bar section). Note that this 
will completely close the program and no alerts will be received. Usual operation 
is not to exit the program but to close or minimize the UserDisplay window 
using the standard controls on the top right/left of the display (see section 
‘Minimize/maximize and close the UserDisplay window’). 
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Replay  
Offers shortcuts to replaying recent events, incoming or simulated. It also shows the 
available keyboard shortcuts for these actions. 

● Play Event opens a file browser so that the user can navigate through the history 
and examples archive and select an event to replay. Both .eew and .xml files are 
available in the examples and history folders, .xml files will replay information 
for a single alert, .eew files will play a sequence of .xml files. Example events are 
divided into region folders: SoCal, NorCal and PNW, plus there are folders for 
history (events received in real-time while UserDisplay has been running) and 
event cancellation. Within region folders is a point source folder, with .xml files 
for events with a single alert, and folders for scenarios (labelled SYN_, usually 
finite fault scenarios) with multiple updates. The keyboard shortcut (ctrl+P) will 
also open the file browser. 

● Replay Last Event replays the most recent event played or received by the 
UserDisplay. The keyboard shortcut (ctrl+R) will replay the most recently played 
event. 

● Event listing displays recently played events for easy selection for replay. Up to 
30 events are listed, using their event ID (for events received in real-time this 
may include the date and time), magnitude, nearest city, and the number of 
updates in the sequence. The keyboard shortcut (ctrl+R) will replay the most 
recently played event (number 1) in the list. 
 

 
 

Edit  
Access your program settings such as the servers you are connecting to, your 
latitude/longitude location, and other specified details.  

● Settings is identical to the Settings button on the Button bar, click to open a 
dialog box to input various details. Note that any feature with an asterisk will 
require a program restart to take effect. 
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o User Settings: 
▪ Checkbox for AutoLogin: Check this box if you wish to be 

automatically logged in each time you launch ShakeAlert 
UserDisplay. Enable only after you have confirmed that your 
Username and Password have been accepted. The password is 
encrypted when saved to disk, so please make sure you know your 
password before running any new version. 

▪ Checkbox for Restore Position and Size at Restart: Selecting 
this checkbox stores the window position and size on shutdown so 
that they can be restored when the program is relaunched. 

▪ Checkbox for Auto Load Recent History: Selecting this will 
automatically load recent events (up to a maximum of 30) into the 
event history layer when the program is relaunched.  

▪ User Home location (lat/lon/zoom): When you first install the 
ShakeAlert UserDisplay, your latitude, longitude and zoom will 
point off the California coast, to remind you to change this to your 
exact location. Convert your address to lat/lon at geocoder.us or 
www.latlong.net. You can set your preferred zoom level, which has 
a ratio format like 1:6,000,000. 

▪ Map Center Location (lat/lon/zoom): Set the map center 
location. 

▪ Use Current buttons fill the lat, lon, zoom boxes with the settings 
from the current map view. When moving the cursor across the 
map, the lat/lon values will be displayed in the lower left corner 
and as you zoom in and out, the zoom level is displayed in a text 
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box near the top in the navigation bar just below the "Play Event" 
button. 

▪ Default buttons reset the lat, lon, zoom boxes to default values. 
▪ VS30 Site Conditions [m/s]: Leave this at the default value. If the 

value 9999 appears in the box, or further explanation of this 
quantity is needed, read the following Advanced users section. 

 
Advanced users:   Enter the Vs30 value (average S-wave velocity of the uppermost 30 m) 

at your location. This value is important for estimating the seismic 
intensity at your site, and will vary depending on the rock or soil type in 
your local area. Enter “0” if you do not know the Vs30 value at your site. 
The program will automatically determine a Vs30 value from a lookup 
table using the latitude and longitude you entered. If the automatic 
lookup attempt results in a value of “9999” in the box, the lookup table 
file is absent or unreadable go to 
https://earthquake.usgs.gov/data/vs30 or contact the appropriate 
person for your region as listed in Section 3 (Download and Installation) 
or Section 5 (Contact Information). 

 
▪ Checkbox for AutoVS: Leave this at its default status, which is 

checked, unless you have more detailed information about your 
site conditions. 

▪ HDPI Font Size Multiplier: This setting is used to adapt the 
UserDisplay to high definition displays. The program attempts to 
set an appropriate level: 0.5, 1.0 or 1.5 depending upon available 
system information. However, if the font appears too large the 
multiplier should be reduced, and vice versa. Higher definition 
screens may need a higher value. 

▪ Map Graphics Quality: The user is able to select between ‘Low 
Quality’, ‘Normal’ and ‘High Quality’, controlling the trade-off 
between the speed and quality with which the view is redrawn. If 
the view is slow to be drawn, select ‘Low Quality’. 

▪ Map Double Buffering: Check this box to apply double buffering, 
which may reduce stutter, tearing and other artifacts in the 
rendering of the view. 

 
o Event Filter Settings: 

▪ To beta test the ShakeAlert UserDisplay, your Minimum 
Magnitude and Minimum Intensity should be low enough to 
detect relatively small (and therefore frequent) earthquakes. 
Default value is usually 1.0. You can raise this value if desired, but 
not by too much.  

 
Advanced Users: You can specify two threshold parameters, which must all be exceeded 

before an event message received by the UserDisplay will be displayed as 
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an alert. Thus, the parameters you set here will control the number of 
alert messages you will receive. Earthquake magnitude represents the 
amount of energy released and depends on the surface area of the 
rupture. Seismic intensity is the amount of shaking, and is a relevant 
measure for potential damage. 

 
▪ Minimum Magnitude: Enter the minimum magnitude of events 

for which you will receive alerts. Take care in setting this value. 
The ShakeAlert System is currently set to issue alerts for events 
with magnitudes “3.5” or above. These smaller events are not 
damaging, but can be used to test the alert system. If you set the 
minimum magnitude too high (e.g., “5.5”), you may not see any 
alerts in the following weeks or months. We encourage you to try 
different magnitude thresholds.  During the beta test period, we 
prefer that you use a small value (e.g. “1.0” to receive all alerts). 

▪ Minimum Intensity: Enter the minimum seismic intensity (MMI 
scale) to be expected at your location for which you want alerts. 
The scale, shown on the lower left of the UserDisplay screen, 
ranges from “1” (not felt) to “10” (extreme shaking). Bear in mind 
that you will not receive alert messages if you set the threshold too 
high. Start with a small value (e.g., “1.0” to receive all alerts). 

 
o Audio Settings: These allow the user some control over the audio alert 

that will be played when an event message is received.  
▪ Checkbox for Alert Tones: toggles the playing of alert tones 

(usually a bell or siren sound). 
▪ Checkbox for Verbal Countdown: toggles the announcement of 

shaking level expected at your location and number of seconds 
estimated until strong shaking arrives.  

▪ Checkbox for Custom Announcement: toggles the playing of a 
custom announcement giving the user basic instruction that an 
earthquake is occurring and protective action should be taken. 

 
o Advanced Settings: Note that changes to these parameters will require a 

restart of the UserDisplay program to take effect. 
▪ ShakeAlert Server List: Default values will be input here, e.g., the 

shake alert servers running at the different geographic ShakeAlert 
centers. A drop-down list will show the servers currently being 
used. The Add, Edit and Remove buttons can be used to add, edit 
or remove ShakeAlert servers. The Default Servers button will 
restore the list of default servers. 

▪ ShakeAlert Port: A default value will be input here, e.g., port 
61617 (or 443) for connection to the ShakeAlert server, and port 
123 UDP for NTP server. Do not change these unless instructed to 
do so.  
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▪ Checkbox for Randomize Connections: Leave this at its default 

status, which is checked. 
▪ Checkbox for Show Detailed Server Status: It is recommended to 

not change this setting. The ShakeAlert Status box shows the time 
and data servers being accessed, as well as any error messages. It 
also shows a latency value in seconds, which is the difference 
between the ShakeAlert system send time and your UserDisplay’s 
receive time for the last message. The default view is a summary of 
each component; checking this box expands the view to show each 
instance of each component. 

▪ Shake Alert Topic: radio buttons allow the user to switch 
between receiving standard alert messages (containing 
earthquake source parameters such as origin time, magnitude and 
location (epicenter and finite fault if available)), contour messages 
(standard information plus ground motion contours), or map 
messages (standard information plus ground motion maps). 
Advanced (pilot program) users can enter a topic name in the text 
box if they know the full description. Do not use this option unless 
arrangements have been made in advance. 

▪ NTP Server Name: It is recommended to not change this setting. 
An alternative NTP server address may be specified. 

▪ TrustStore File Path and Password: Most users should not need 
these settings. Users participating in pilot programs may be sent a 
trust store file and details should be entered here. The file button 
can be launched to navigate the file system to the correct file. 

▪ Checkbox to Show Password in plain text. 
 
Notes:  
○ Any changes to Server Name, Port, or the AutoLogin checkbox will cause the Login 

dialog box to appear. 
○ The Default button can be used to restore the default settings. 
○ If you edit any of these settings, click OK. Click Cancel to discard changed settings 

you decide you do not want enabled. 
○ The Default All button will set all values in the dialog to their default settings. 
 

● Layers launches a dialog to edit the layers visible in the main UserDisplay 
window, such as displays of roads and towns, and event features such as P and S 
wavefronts. This gives the user greater control to switch both map and event 
features on and off in their display. N.B Enabling many map layers increases the 
graphics processing requirements. If you notice delays or stuttering in map 
rendering, try reducing the number of map layers enabled. 
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Seismic Information  
Event Info Shaking intensity banner, event information panel, star 

showing epicenter location, status information. 
Event waves P and S-wavefronts displayed as yellow and red circles. 
Rupture Location Shows finite fault rupture 
Intensity map Displays the seismic intensity provided in the ground 

motion map message as a coarse grid. Color is from the 
Modified Mercalli Intensity Scale (MMI). 

Intensity contour Displays the seismic intensity polygons provided in the 
ground motion contour message, which are simple 
8-vertex polygons. Color is from the Modified Mercalli 
Intensity Scale (MMI). 

Event History Recent events (live and replayed) are shown as squares, 
colored by age and sized by magnitude. Events can be 
replayed by double-clicking. 

o Red: less than one hour 
o Blue: less than one day 
o Yellow: less than 7 days 
o Grey: more than 7 days 
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Ground Motion Symbols Shows station ground motion observations. They are 

shown colored by shaking intensity with symbol 
denoting prediction or observation, and differentiating 
between displacement, velocity and acceleration. 

Stations Network stations contributing data to the earthquake 
early warning system. Note that symbols (small yellow 
triangles) will only be visible at higher zoom levels. 

Legends MMI intensity scale, disclaimer. 
Typical Blind Zone Region around the user’s location denoting the zone 

where, if an earthquake were to start there, the user 
would likely have a zero warning time. 

Map Features  
Towns Markers and names, scaled by population. 
CA faults Fault traces shown as thin grey lines. 
WC roads Shown as orange lines. 
WC faults Fault traces shown as thin grey lines. 
WC streams Blue lines. 
WC lakes Blue regions. 
WC urban centers Pink shading showing major urban centers. 
PNW tectonic Plate boundaries marked in white (includes San 

Andreas in California). 
PNW volcanoes Marked and labelled. 
CA counties Boundaries shown as black lines. 
WC states Shows California, Oregon and Washington state areas as 

white regions. 
Political boundaries Shows global landmasses as blue regions with black 

country borders. 
Background Changes the background to a gradient blue from top to 

bottom. 
 
Notes:  
○ Only visible layer selections made by the user are persistent through a program 

restart. Controls are present for other user modifications: arrows for layer re-ordering, 
plus/minus buttons for adding or removing layers, edit option for each layer. We do 
not describe them further here as we suggest the user should not make use of 
these features in this UserDisplay version. Any changes made would not be 
persistent though a program restart, and would need to be made each time the 
program is launched. 

○ The vertical arrangement of names in the Layers dialog window represents their 
relative hierarchy on the display map. The mapping engine will draw the layers at the 
top of the list after drawing those at the bottom, so layers at the top of this list will be 
visible ‘above’ layers at the bottom. The user should beware of this behavior if moving 
large area layers (e.g. WC states) to the top of the list. 
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View 
Change or refresh your display using the selections here. 

● Reset Map changes your view of the map back to your preferred settings (see 
Settings panel). You can also use keyboard shortcut Ctrl-L. 

● Clear Display clears all alerts and other icons from the map. You can also use 
keyboard shortcut Ctrl-D. 

● Toggle FullScreen opens your program window to fill the screen (FullScreen) or, 
by clicking again, returns it to a smaller window. You can also use keyboard 
shortcut Ctrl-F. 

● Show Status opens the ShakeAlert Status box, showing the time and data servers 
being accessed, as well as any error messages. It also shows a latency value in 
seconds, which is the difference between the ShakeAlert system send time and 
your UserDisplay’s receive time for the last message. You can launch this same 
box by double-clicking the Status Indicator light (the box that should be Green 
when properly connected) on the Button bar. 

● Show Log opens a window and displays log messages. 
● Load Examples offers a sub-menu of standard, contour or map, which determines 

whether the loaded example messages will contain ground motion information. 
Selecting one of these will load example events into the history layer for easier 
replay. Events are shown as boxes colored by time. Since all example events are 
old, they will appear as grey boxes. Note that if the user wishes to add further 
examples, they must be placed in the region folders (within replay_data 
directory, there are directories NorCal_examples, SoCal_examples and 
PNW_examples). Alternatively, if the user wishes to keep new examples in a 
separate folder, the ExamplesDir in the app.properties file can be added or 
edited to provide a full comma-delimited list of replay directories, e.g.: 

o ExamplesDir=replay_data/NorCal_examples,replay_data/SoCal_examples,
replay_data/PNW_examples,replay_data/My_examples 

● Load Recent History loads the most recent events from the user’s history folder 
into the history layer for easier replay. Up to 30 events will be shown. Events are 
shown as boxes colored by time. Since a number of events may have occurred at 
the same, or close, geographic locations, clicking on any event in the example or 
history layer will launch a pop-up menu listing the available events to play 
(figure below). Events are listed using their event ID (for events received in 
real-time this may include the date and time), magnitude, nearest city, and the 
number of updates in the sequence. Clicking on any event in the menu begins the 
replay. 
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● Clear Examples removes example events from the history layer. 
● Clear Recent History removes recent history events from the history layer. 
● Show Legend launches a pop-up containing a legend for the symbols and scales 

shown on the map (see below). This includes the event symbols, their size and 
color-scaling, the MMI (intensity) color scale and other symbols that appear on 
the map such as site ground motion observations or recording stations. 
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Help 
View documentation about ShakeAlert, including version details, copyright, end-user 
license agreements, and user guide link, and also access “Check for Updates” feature. 

■ About displays ShakeAlert UserDisplay version number and copyright 
information. Additional information is also provided including: the time 
the program was started, user information, system description, software 
library details and the UserDisplay properties file. 

■ Readme displays ShakeAlert UserDisplay README file. Note that this file 
contains useful reference information such as default server addresses 
and program configuration. 

■ Changes displays ShakeAlert UserDisplay Changes file. Note that this file 
contains information on bug fixes and new features available with 
different versions. 

■ User Guide provides location information for the user guide, and on some 
platforms provides a hyperlink to launch the online user guide. 

■ End User License Agreement displays the End User License Agreement 
that you must accept in order to use the ShakeAlert UserDisplay. 

■ Check for Updates has the program check for any pending updates to the 
interface. 

 
Button Bar 

● Power-off icon. Clicking this icon will terminate the UserDisplay program. You 
will not get any more alerts until you restart the UserDisplay program. 

● Program Status Light. Click or hover cursor over the status light square, to the 
right of the Power icon, for information regarding connection status. 

 
Green: The communication between the ShakeAlert system and your 
UserDisplay is healthy. You will be able to receive alert messages. 

 
 Grey: There are either internal problems with the ShakeAlert system or 

communication problems between the ShakeAlert system and your 
UserDisplay. The communication may still be healthy and you may receive alert 
messages. 

 
Yellow: The ShakeAlert system is only partially operational or there is a 
connection problem to the Network Time Server. You are likely to receive 

alert messages. If an ‘NTP Error’ is showing, try re-connecting to the time server 
(UserDisplay menu > Reconnect to Time server). 

 
Cyan: The user’s computer is not connected to the internet.  

 
Red: There is a connection problem to either the ShakeAlert servers, or 
the UserDisplay program is unable to synchronize with a Network Time 
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Server. Make sure your computer has a working Internet connection and that no 
firewalls are blocking that connection. Try re-connecting to the time server 
(UserDisplay menu > Reconnect to Time server). 

 
            Problems connecting to the Network Time Server (NTP) are reflected in the color 

of the program status light, as well as connection issues for receipt of ShakeAlert 
earthquake notifications. If the status light is yellow or red and an “NTP Error” is 
identified, this can lead the event info panel on the left to report incorrect 
warning times. NTP status messages are also included in the main log accessible 
within the program (from the top Menu bar, click View > Log). If errors with 
specific components of the ShakeAlert servers are indicated the user does not 
need to take any action. 

 
● Settings button opens the Settings dialog box; for details, see Top Menu Bar > 

Edit > Settings. 
● Play Event button is the same as selecting from the Top Menu Bar, Replay > 

Play Event, and launches the Select Event dialog box so you can choose a past 
event to replay. 

 
Advanced Users: XML-messages from the ShakeAlert system that have been 
received by the UserDisplay (while connected to power and internet) will be stored 
on your computer in the “history” folder. When you click on the "Play Event" 
button, an open-file dialog appears. You may click on one of the subfolders (within 
the history folder the name of the subfolders indicates the ShakeAlert eventID; note 
that this id is different from the eventID that is used in ShakeMap for instance) and 
replay an event by double-clicking on the file with the “.eew” extension. The event 
will not be displayed, if the threshold parameters in “Settings” are not exceeded, or 
if the warning time is zero or negative. 

 
Starting with release v2.4, the ShakeAlert UserDisplay is capable of processing and 
displaying finite fault ruptures and the estimated slip along these ruptures. This 
feature improves intensity estimates at the user’s site for large earthquakes 
(M>6.5). To get more familiar with the finite fault capabilities of the UserDisplay, 
we recommend replaying the examples from the “examples” folder. For each 
geographic region, you will find examples for a number of scenario earthquakes in 
folders “SYN_”. Click on the .eew file to start the corresponding animation. For 
scenarios in the “SYN_” folder, the grey line shows the estimated rupture of the 
earthquake. The UserDisplay will use the closest distance between the rupture and 
your site to calculate the expected intensity that you would feel if this event were 
real.  

 
● Cancel button cancels the playing (real or simulated) of an event. This is for 

people running demonstrations of ShakeAlert UserDisplay and should not be 
used by other users, as it may result in you not receiving relevant alerts when 
earthquake parameters are updated.  
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● Silence button quiets a current alarm. You can also use keyboard shortcut 

Ctrl-S. This feature mutes ONGOING alerts, for example to suppress audio alerts 
for distant earthquakes with long warning times that may be irrelevant to the 
user. 

● Mute checkbox will silence all incoming and simulated alarms. You can also 
mute alarms with the keyboard shortcut Ctrl-M. The “mute” button is useful to 
silence the UserDisplay during a large aftershock sequence after a strong 
earthquake. 

 
Top of Program Status/Shortcuts 

Hover your cursor over the “SA” icon at the top of your computer window (or wherever 
your taskbar or dock is located) to view the ShakeAlert UserDisplay version number, 
current date and time, and current connection status to the ShakeAlert servers. The 
color of the icon shows the UserDisplay status (see the Program Status Light section 
for explanation of color codes). 
 
Some caveats: 

● Linux users have reported that the resulting status message does not wrap 
properly. 

● Windows users will find the SA icon in their Notification Area (see Figure 4). 
Click the up-arrow on your task bar to open the Notification Area.  

● Windows users can customize the system tray so the ShakeAlert icon is always 
visible in the task bar. Right-click the task bar, select Properties, and click 
“Customize…”; on next screen, choose “Show icon and notifications” for 
ShakeAlert UserDisplay (JavaTM Platform). 

 
If you click once (Mac) or right-click (Windows/Linux) on the “SA” icon, you will get 
information on the running version and properties file plus three shortcuts for the 
program: 
Settings: Displays the Settings dialog box 
Show: Brings the ShakeAlert program from a minimized state 
Exit: Exits, or shuts down, the ShakeAlert UserDisplay 
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Minimize/Maximize and Close the UserDisplay Window 

 
Standard operation of UserDisplay is to close the window using the ‘Close Window’ 
button. This will ensure that the UserDisplay will still be running and will pop up 
automatically when an event alert is received that meets the user’s alert criteria. The 
status icon on your taskbar or dock is the indication that UserDisplay is still running. 
Minimizing the window will lead to the same behavior. (Click the Power Off icon on the 
Button Bar to terminate the program completely.) 
 
Map Navigation 

The navigation buttons allow you to move around on the ShakeAlert UserDisplay. 
 

 
● Pan: This button on the far left, when its arrows are clicked, allows you to pan 

east, west, north, south (horizontal and vertical arrows), as well as northeast, 
northwest, southwest, and southeast (corner arrows). Click center of this icon to 
center the state of California in your window. 

● Zoom: Click the Plus magnifying glass to zoom into the display, and the Minus 
magnifying glass to zoom out. 

● Select: Change your cursor to a selector, e.g., to click buttons, select events for 
replay. 

● Area Zoom/Move: Click on the button to use mouse clicks and drags to control 
map positioning. Clicking on the top, bottom or sides of the map area will move 
the map in the desired direction. Clicking and holding the left mouse button 
allows the user to drag to select a desired map area. The area is centered on the 
position of the mouse click. 

● Drag: Click on the hand and then click-hold on the screen, to drag the display to 
where you wish. 

● Edit Layers: Click on the Layers button to launch a dialog to edit the layers 
visible in the main UserDisplay window, such as displays of roads and towns, 
and event features such as P and S wavefronts. This gives the user greater 
control to switch both map and event features on and off in their display. Further 
details can be found in the section Top Menu Bar > View > Edit Layers. 

● Zoom level: Edit the zoom level scaling manually.  
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4. Alert Information 
When the UserDisplay receives an XML alert message from the ShakeAlert System, the 
following information will be displayed (provided that your thresholds in “Settings” are 
exceeded and the remaining warning time is greater than 1 second: 
 

 
 
The following symbols appear on the map after an event occurs: 

● Red star – Location of current event 
● Thick grey line – Finite fault rupture (only visible if an algorithm that calculates 

finite fault reports for the event) 
● Yellow triangles (pointed up) – Approximate location of earthquake sensing 

station(s) 
● Ground motion symbols, color coded by MMI at each location. If an algorithm has 

reported ground motion information for a particular station location, a 
color-coded symbol will appear, and if the cursor is hovered over the symbol 
information on the station code and ground motion value will be given. See the 
legend for which symbol represents which type of ground motion. 

● Ground motion contours or maps - Polygons or grids color-coded by MMI for 
predicted shaking intensities (see screen captures below). These will appear if 
UserDisplay is configured to receive the contour or map message topic. 
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A. Map: Your location is shown by a blue house, and the estimated location of the 

earthquake by a red star (and/or a thick grey line if a finite fault solution is 
displayed). The map is automatically centered on a point halfway between the 
two locations. The yellow and red radiating circles show the estimated locations 
of the P- and S-wavefronts of the earthquake, respectively.  
P-waves, which travel faster than S-waves, rarely cause damage because 
amplitudes are smaller and ground motions are predominantly in the vertical 
direction. The yellow circle, representing the P-wavefront at a given time, will 
always be larger than the red circle (S-wavefront). Damage is typically caused by 
S-waves.  
The “remaining time” is the estimated time it will take for the S-wavefront (red 
circle) to reach your location. For some events you will also see estimated or 
observed ground motions at various sites shown by filled inverted triangles or 
circles respectively.  
The map will also display the information “Event Cancelled” or “This is a Test”, if 
an event has been cancelled or if a test message was received. Additional status 
information is displayed in the same way:  
● “Server Error” if the servers have an error status; 
● “Connection Error” if the time or message server cannot be reached; 
● “System Offline” if the servers are offline; 
● “No Connection” if no connection to the servers can be established; 
● “No NTP Connection” if  unable to connect to an NTP server; 
● “Program Error” for unclassified errors; 
● “Playback” for an event replay. 
You may notice a grey circle around your location. This approximates the area 
where, if an earthquake starts within this region, ShakeAlert is extremely 
unlikely to alert you before shaking arrives. If an earthquake occurs within this 
area, you will likely experience the shaking before you could receive an alarm. 
We are working to decrease the radius of this area in future versions of the 
ShakeAlert system. 

 
B. Information Panel: The panel on the left side of the screen gives the estimated 

time (in seconds) remaining until shaking is expected to begin at your location, 
the estimated seismic intensity (MMI scale), and the estimated magnitude. The 
Information Panel also gives the Probability of Correct Alarm (PCA); we have 
introduced three PCA levels: “low”, “moderate”, and “high”. The top section of the 
panel gives event ID, estimated event origin time and epicenter. 

 
C. Top Panel: the top panel describes the level of expected shaking at your site (in 

words and in color), e.g. “Light Shaking Expected”. 
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Finite fault detection capability of UserDisplay. Thick grey line shows extent of current fault rupture. 

 
 

Ground motion message contour display in UserDisplay. Contours are colored by intensity scale shown. 
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Ground motion message map display in UserDisplay. Grid points are colored by intensity scale shown. 

 
Expected MMI level will be shown on the map and in the lower right for the current cursor position when 

either map or contour messages are displayed. 
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Important: Do not forget to turn on the volume of your computer, and do not check 
the “mute” box at the top of your UserDisplay if you want to hear alert messages (siren 
and voice announcement). 
 
 
This Operations Guide was written by M. Böse and J. Andrews (Caltech), with project 
overview and installation instructions provided by members of the JCCEO (Joint 
Committee for Communication, Education, and Outreach), and with input from past and 
present members of the ShakeAlert EEW Group from the following institutions: UC 
Berkeley, California Institute of Technology (Caltech), ETH Zurich, USC/SCEC, US 
Geological Survey. 

 

5. Contact information 
For questions or feedback please contact: 
 

Southern 
California 

Margaret Vinci  
(Caltech) 

mvinci@gps.caltech.edu 626-395-3298 

Northern 
California 

Jennifer Strauss  
(UC Berkeley) 

jastrauss@berkeley.edu 510-642-1067 

Oregon Lucy Walsh 
(University of Oregon) 

lwalsh@uoregon.edu 541-346-4654 

Washington Bill Steele  
(University of Washington) 

wsteele@uw.edu 
 

206-685-5880 

USGS Robert de Groot  
(USGS) 

rdegroot@usgs.gov 626-583-7225 

 
Additional information on the ShakeAlert project can be found at 
https://www.shakealert.org. Thank you very much for your participation. We are 
looking forward to your feedback. 
 
  

26 
 

https://www.shakealert.org/


 

6. Troubleshooting 
You may encounter one or more of the following issues when running the UserDisplay: 
 
1) Problem:  Warning time is excessive for location of epicenter 

Solution: Check the computer’s internal clock. If the computer’s clock is incorrect, it 
will adversely affect the accuracy of warning time. Verify the connection to the NTP 
server to obtain correct time information. 

2) Problem: UserDisplay did not record recent events in your absence. 

Solution: Turn off “sleep mode” on your computer. 

3) Problem: Computer slow to respond or locks up when UserDisplay is running. 

Solution: Computer resources are insufficient to run the UserDisplay. Close 
non-essential applications. 

4) Problem: Not receiving ShakeAlert email notices about planned tests, etc.  

Solution: Make sure your correct contact information is in our database. Contact 
your ShakeAlert Regional Coordinator as listed in Contact Information Section.  

5) Problem: Gray circle around Home does not update when location is changed in 
settings window. 

Solution: Force a redraw of the main window by changing the zoom level or pan the 
display around. Note that the grey zone is only an estimate. It is not used for any 
calculations within the UserDisplay. 

6) Problem: What do the different status colors mean: green, grey, yellow, cyan or 
red? 

Solution: Click or hover cursor over the status box for information regarding 
connection. See the section Button Bar > Program Status Light for detailed 
descriptions of status light. 

7) Problem: “CONNECTION PENDING” appears in red on map, status may be any color. 

Solution: No connection yet. If problem does not resolve itself within a few minutes, 
check your Internet connection. 

8) Problem: “NO CONNECTION” appears in red on map, status may be any color. 

Solution: No connection to ShakeAlert server.  Make sure computer has access to 
the internet.  Check ShakeAlert server and port settings.  See README file for list of 
servers and ports.  If there was a connection problem and the problem does not 
resolve after several minutes, you can use the UserDisplay > Reconnect to 
ShakeAlert server menu item to try re-establishing your connection. 
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Instead of the default port 61617, you could try using port 443 in the Settings dialog. 
You will need to restart the program after making any changes to the server 
settings. 

9) Problem: “NO NTP CONNECTION” appears in red on map, status may be any color, 
pop-up text says “NTP ERROR”. 

Solution: Problem connecting to NTP server.  Note that it may take several minutes 
for this to update. If the problem does not resolve after several minutes, you can use 
the UserDisplay > Reconnect to ShakeAlert  server menu item to try re-establishing 
your connection. 

Alternative settings for the NTP server can be configured using the NTP Server 
Name field in the Settings dialog, launched from Settings button or Edit > Settings 
menu option. The default NTP server is currently set to time.nist.gov. Try changing 
to other NTP servers such as us.pool.ntp.org or ntp-01.caltech.edu. Each time you 
change the NTP server you will need to exit the UserDisplay program (UserDisplay > 
Exit or the red ‘power off’’ icon on the left of the button bar) and restart the 
program. 

10)Problem: “SYSTEM OFFLINE” appears in red on map and status may be any color. 

Solution: Unless you just tried to change the NTP connection, there may be a 
problem with one of the ShakeAlert servers.  If the problem does not resolve itself in 
a few minutes you could try to force a reconnect using UserDisplay > Reconnect to 
ShakeAlert server or quit and restart the program.  It may take several minutes for 
the status to refresh while the program is trying to reconnect.  

11)Problem: There are no events in my history folder to select for replay. 

Solution: When the software is first downloaded there will be no events in the 
history folder. This is where alerts are stored that have been received by the 
UserDisplay while it has been running. See the README file in your installation 
directory for instructions on how to copy old history files from a previous version. 

12)Problem: Error message appears with the message that you cannot connect to the 
ShakeAlert server. This is most likely due to your institution’s restrictions on port 
access through firewalls for example. 

Solution: Launch the Settings dialog using the button on the button bar and change 
the port number from the default 61617 to 443. Press OK, exit the UserDisplay and 
restart. 

13)Problem: When I double-click on the UserDisplay launch icon nothing appears, I do 
not see the ShakeAlert UserDisplay splash logo. 

Solution: There is likely a problem with the java installation and the UserDisplay 
program cannot be launched. Try re-installing java. 
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14)Problem: When I double-click on the UserDisplay launch icon I do see the 

ShakeAlert UserDisplay splash logo but the program does not start. 

Solution: There is likely a problem with the UserDisplay installation. Try 
re-installing the ShakeAlert UserDisplay program. 

15)Problem: When launching UserDisplay I get an error pop-up dialog saying there is a 
file missing or problem copying a file. 

Solution: There is likely a problem with the UserDisplay installation. Try 
re-installing the ShakeAlert UserDisplay program. 

16)Problem: When launching UserDisplay I get a warning pop-up dialog saying there is 
a newer configuration file available, would you like to replace. 

Solution: Select ‘Yes’ to use the new file and a backup copy of your old file will be 
made should you want to revert (by manually replacing the new file with the old in 
your local directory). Select ‘No’ to use your existing file but note you will be 
prompted at each program re-start. 

 

7. Known Issues 
1) Issue: The UserDisplay flickers and/or is incompletely redrawn and/or the audio is 

uneven during an earthquake alert. 

This is a known problem with the current Java 8 update 121, which was released 
January 17, 2017. It does not affect all computers but appears to be particularly 
worse on Windows. Previous versions of the UserDisplay may also be affected by 
the recent java updates. Reverting to versions of Java 8 prior to 101 should improve 
the display. It may also help to disable some of the more detailed map layers. 

 
2) Issue: UserDisplay does not always recover from an incorrect server/port 

combination. Using UserDisplay menu options to reconnect does not always work.  

Confirm valid connection to Internet. Correct server and port entries and restart 
program.  
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8. Appendix A 

Rev.  March 15, 2018 

 
ShakeAlert License Agreement and Terms of Service (Beta User) 

YOU ARE ADVISED TO READ THIS AGREEMENT FULLY AND CAREFULLY AS IT 
CONTAINS OBLIGATIONS TO BE MET BY YOU AND ALSO INCLUDES A TRANSFER OF 

RIGHTS BACK TO USGS FOR FUTURE DEVELOPED TECHNOLOGY. 

This Agreement is entered into between the United States Geological Survey (“USGS”), a 
bureau of the Department of Interior, having offices at 12201 Sunrise Valley Drive, 
Reston, Virginia, 20192, and you (LICENSEE). This Agreement covers ShakeAlert 
products and services including  the ShakeAlert server connections, data streams, the 
User Display application, other software, algorithms, associated media, printed 
materials, data, files and information and any online or electronic documentation 
(hereinafter “ShakeAlert Materials”). 

            BACKGROUND. 
1. The USGS is authorized to develop a system capable of sending earthquake warning 

notifications as established by the Disaster Relief Act (P.L. 93-288, popularly known 
as the Stafford Act) and the National Earthquake Hazard Reduction Program, as 
enacted by the Earthquake Hazards Reduction Act of 1977, 42 U.S.C. §§ 7701 et seq. 
USGS, in partnership with the University of Washington, Caltech, UC Berkeley, and 
the University of Oregon is continuing to develop an Earthquake Early Warning 
(EEW) system. USGS’s specific research objective is to develop the capability of 
issuing an alert within seconds of detecting an earthquake, thereby providing 
warning before destructive shaking arrives. This alert is currently delivered through 
a prototype system encompassed by the ShakeAlert materials, provided under this 
license. 

 
2. This agreement is entered into under the authority of the Federal Technology 

Transfer Act of 1986, codified in 15 USC 3710(a), as amended. The purpose of this 
agreement is to further the research and development of the ShakeAlert Materials 
through a “beta test” that will provide valuable feedback from each LICENSEE 
regarding the functionality of the ShakeAlert Materials. 

 
3. The ShakeAlert Materials licensed under this agreement include real-time data 

streams that may include parameters derived from ground motion records, ground 
motion estimates, or earthquake source information including origin time, location, 
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magnitude, and fault rupture description and duration. These information streams 
begin shortly after an earthquake starts and update as the earthquake develops. 

 
4. The ShakeAlert Materials licensed under this agreement include an application 

currently referred to as UserDisplay that may run on a LICENSEE’s computer and 
presents visual and audio information about the earthquake and when and how 
strong shaking will arrive at the user’s location. 

 
AGREEMENT 

For good and valuable consideration, the receipt and sufficiency of which are 
hereby acknowledged, the parties agree as follows: 

1. License Grant. USGS grants LICENSEE, and LICENSEE hereby accepts, a 
non-exclusive, non-commercial, non-transferable, revocable without cause license 
to use ShakeAlert Materials provided that: 
a. LICENSEE shall not copy, modify, reverse engineer, publish, rent, lease, loan, 

sublicense, or distribute ShakeAlert Materials or derived products to any 
third-party without the prior written consent of USGS; 

b. Shall not offer for sale, advertise, distribute or otherwise publicaly offer any 
product or service relating to the ShakeAlert Materials; 

c. LICENSEE must obtain prior written approval from the USGS for any public 
information releases which refer to the Department of the Interior, the USGS, its 
employees, or ShakeAlert Materials. 

d. LICENSEE shall inform USGS in writing within seven (7) days of any engagement 
with contractors, consultants, grantees or other third-parties related to their use 
of ShakeAlert Materials. USGS may determine, at its sole discretion, if such 
engagement requires third-parties to also execute this or another form of license 
agreement. 

e. LICENSEE shall not allow ShakeAlert Materials to be accessed over a network or 
the internet in a manner that would allow users to access ShakeAlert Materials 
who are not employed by LICENSEE, without the prior written consent of USGS; 

f. LICENSEE shall not interfere with or disrupt USGS or ShakeAlert servers or 
networks or servers or networks connected to them, or disobey any 
requirements, procedures, policies or regulations of ShakeAlert servers or 
networks; 

g. LICENSEE is limited to five (5) concurrent connections to ShakeAlert servers 
unless granted additional connections, in writing, by USGS. 

 
2. Maintenance and Support. USGS is under no obligation to provide maintenance for 
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ShakeAlert Materials or notify LICENSEE of any fixes, patches, or updates to 
ShakeAlert Materials. If, in its sole discretion, USGS makes an update available to 
LICENSEE, it shall be deemed incorporated into the ShakeAlert Materials and 
subject to this Agreement. USGS reserves the right to make any and all changes to 
ShakeAlert Materials that it deems necessary to maintain and improve the function 
of the system. 

 
3. Feedback. As consideration for this Agreement, the LICENSEE shall, upon request of 

USGS, provide suggestions and feedback regarding the ShakeAlert Materials, 
including, but not limited to, functionality, design, usability, bugs, and results of any 
testing performed by LICENSEE. 

 
4. Passwords and Security. LICENSEE is required to register as an authorized user 

for access to ShakeAlert Materials. Registration will include a user name, password 
and contact information (“User Credentials”). For convenience, usernames shall 
reasonably reflect the name of the LICENSEE. User Credentials must be kept 
accurate and up-to-date. LICENSEE is responsible for maintaining the confidentiality 
of its User Credentials and shall not share its User Credentials with anyone or use 
the User Credentials of others. USGS reserves the right to disable, delete or change 
Authorized User Credentials at any time and for any reason without notice. 

 
5. Attribution. If LICENSEE publishes research or otherwise publically discloses 

information related to the ShakeAlert Materials that is not prohibited by this 
Agreement, then LICENSEE shall give appropriate credit to the USGS as the source of 
ShakeAlert Materials. LICENSEE may do so in any reasonable manner, but not in any 
way that suggests the USGS or U.S. Government endorses the LICENSEE or its 
products, services or opinions. 

 
6. Prohibition on the Distribution of Warning Signals. LICENSEES are not 

authorized to transmit messages, notifications, alerts, or warnings derived from the 
ShakeAlert Materials to the public unless specifically agreed to in a separate written 
agreement with USGS. 

 
7. No Warranties Unless Expressly Provided. ShakeAlert Materials are licensed for 

the purpose of continued research and development and, except as specifically 
stated in this Agreement, the parties make no express or implied warranty as to any 
matter whatsoever, including the conditions of the research or any invention or 
material, whether tangible or intangible, made or developed under or outside the 
scope of this Agreement, or the ownership, merchantability, or fitness for a 
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particular purpose of any research, invention or material, or that a technology used 
by a Party in connection with the ShakeAlert Materials, or the ShakeAlert Materials, 
does not infringe any third-party patent rights. Furthermore, USGS does not warrant 
that ShakeAlert Materials will function at all times, in all geographic areas, be 
error-free or that any errors will be corrected. 

 
8. Licensee Warranties.  The LICENSEE warrants that: 
 

a. It has authority to enter into this Agreement; 
b. The signatory has the authority to sign on behalf of the LICENSEE; and 
c. The LICENSEE or any of the LICENSEE’s personnel involved in performance 

under this Agreement are not debarred or suspended by any agency of 
Government. This warranty requires the LICENSEE to notify USGS if LICENSEE, 
or any personnel, becomes debarred or suspended during the term of this 
Agreement. 

 
9. Indemnity. LICENSEE shall indemnify, defend, and hold harmless the U.S. 

Government, its agents, officers, and employees against any and all claims, suits, 
losses, damage, costs, fees, and expenses arising out of or in connection with 
LICENSEE’s use of ShakeAlert Materials pursuant to this Agreement. 

 
10. Copyrights. LICENSEE shall not claim, file for or otherwise acquire an interest in 

any copyrights in the Shake Alert Materials. However, work performed by LICENSEE 
by virtue of its use of ShakeAlert Materials under this Agreement may generate 
copyrightable works of the LICENSEE, including software. LICENSEE grants to the 
Government a nonexclusive, irrevocable, paid-up license in such copyrighted works 
resulting from the work accomplished by virtue of this Agreement. Collaborator 
shall include the following statement on any copyrighted work(s) created by virtue 
of this Agreement: “The U.S. Government has a copyright license in this work 
pursuant to an agreement with the U.S. Geological Survey, a bureau within the 
Department of Interior.” 

 
11. Patents and Trade Secrets. LICENSEE shall not claim, file for or otherwise acquire 

an interest in any patents or trade secrets for the ShakeAlert Materials. However, 
work performed by the LICENSEE by virtue of its use of the ShakeAlert Materials 
under this agreement may generate patentable materials and/or trade secrets of the 
LICENSEE.    The LICENSEE grants to the Government a nonexclusive, 
nontransferable, irrevocable, paid-up license to practice or have practiced any 
invention made by LICENSEE by virtue of this Agreement, regardless of whether the 
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invention is patented, claimed as a trade secret or otherwise proprietary to 
LICENSEE, throughout the world by or on behalf of the Government for research or 
other Government purposes. Any patent application filed for an invention conceived 
or reduced to practice in the performance of this Agreement shall contain the 
following statement: “This invention was created in the performance of an 
agreement with the U.S. Geological Survey, a bureau within the Department of 
Interior, which has certain rights in this invention.” 

 
12. Term and Termination. This Agreement is perpetual unless terminated by either 

Party. USGS may terminate at any time without reason and may terminate 
regardless of whether LICENSEE is in breach of this Agreement. Termination shall 
be exercised in the sole discretion of USGS and USGS shall not be liable for any 
damages claimed by LICENSEE as a result of the termination of this Agreement. 
Upon termination, LICENSEE shall immediately cease utilizing ShakeAlert Materials 
and return to USGS or destroy all copies of the ShakeAlert Materials in accordance 
with instructions from USGS. 

 
13. Governing Law. The validity and interpretation of this Agreement are subject to 

interpretation under Federal Law.  
 
14. Entire Agreement. This Agreement represents the entire understanding of the 

Parties, and supersedes all previous communications, written or oral, relating to the 
subject of this Agreement. If either Party desires a modification to this Agreement, 
the Parties shall, upon reasonable notice of the proposed modification by the Party 
desiring the change, confer in good faith to determine the desirability of the 
modification.  No modification shall be effective until a written amendment is signed 
by the signatories to this Agreement or their designees. 

 
15. Survivability.  When necessary to effectuate the intent of this Agreement, 

individual provisions shall survive expiration or early termination. 
 
16. Export Controls.  Collaborator agrees to comply with U.S. export law and 

regulations. 
 
17. Severability. If a provision of this Agreement is found illegal or unenforceable, it 

will be enforced to the maximum extent permissible, and the legality and 
enforceability of the other provisions of this Agreement will not be affected. 
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